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Introduction 
Features 

 Plays back DVD Folder, MPEG1, MPEG2, DivX/Xvid (AVI) movie files, MP3, WAV music 

files, JPEG photo and graphic files. 

 Supports NTFS file system. 

 Supports both NTSC and PAL TV systems. 

 Supports 1080i video output. 

 Supports HDMI and component video output. 

 Supports Music Slideshow 

 Supports AV recording and scheduled recording. 

 Supports external USB storage media playback. 

 Supports playback via SAMBA Ethernet protocol. 

 Supports USB wireless dongle. 

 Supports Transcode utility for extended codec support of Ethernet playback. 

System Requirements 
A desktop or notebook PC with Ethernet port 

Available USB connection 

350 MHz Pentium class processor or higher 

Operating systems: Microsoft® Windows® Vista� / XP SP2 
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The Remote Control 
Using the Remote Control for the First Time 

For the first time use of the remote control, pull out the tab to 

enable the battery power of the remote control. 

Changing the Battery of the Remote Control 
If the battery becomes depleted, change the battery according to the following instructions: 

Take out the battery holder

Turn the remote control on its back, and then press the tab 

on the left side with fingernail . Hold and pull at the 

indentation  to take out the battery unit. 

 
Load the new battery

(+ towards up)

The battery model of this remote control is CR2025. Refer to 

the illustration to insert the battery accurately with the 

positive terminal facing up – see illustration below. 

Insert the battery holder

Place the new battery and make sure it is inserted and seated 

securely. 

 

 Note:
 

• This device must be activated before it will respond to commands from the 

remote control. 

• When using the remote control, point the remote control towards the front 

of this device. 

• The  icon will appear on the screen when a button of non-available 

operation is pressed.  

 



The Remote Control 

3 

Buttons 

 

○1   STANDBY: Activate this device / Return to Standby

○2  TV SYS Switch output TV system 

○3  SETUP: Enter Setup Menu 

○4  SOURCE: Switch among HDD/USB/Network/ 

AV-IN/Schedule 

○5  AUDIO: Switch audio tracks in a movie 

○6  SUBTITLE: Switch DVD subtitles; DivX sub On/Off.

○7  ANGLE: Switch DVD angles 

○8  ZOOM: Enlarge image 

○9  RETURN: Return to parental folder 

○10  SLOW: Slow motion playback 

○11   REC: Start recording/ repeat press for record 

length setup 

○12  DELETE: Delete files (in browsing mode only) 

○13  : Cursor buttons 

○14   ENTER: Play/Pause the current selected file or 

folder 

○15   HOME: Return to Home Menu 

○16  MENU: Display DVD menu 

Show menu dialogue box (in browsing mode only) 

○17   STOP: Stop current playback 

○18  / : Fast rewind / Fast forward 

○19  / : Play the previous / next file 

Previous page / next page (in browsing mode only) 

○20  0~9: Number pad 

○21  DISPLAY: Display file properties / played time 

○22  GOTO: Jump to a specific point on a title in playback 

○23  A-B: Repeat from A to B 

○24  REPEAT: Change the repeat mode 

○25  / : Volume up / Volume down 
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Parts and Functions 

 

○1  Remote LED: (Orange) Blinking: Received a remote control signal. 

Triplet blinking: HDD error/ First time firmware installation/ Forbidden 
operation 

On: Recording in progress. 
○2  Power LED: 

(Blue) 

Off: Standing by. 

On: Activated. 

On with 2 blinks every 5 seconds: Scheduled recording standing by. 

Fast blinking: Booting up/ Accessing data through PC connection. 
○3  Power switch: Press and hold this button for about 3 seconds to turn off this device. 

○4  USB type A connector: Connect the USB mass storage devices/ USB wireless dongle with this 
device using a USB cable. 

○5  USB connector: Reserved 

○6  HDMI connector: Outputs digital video/audio signals with a HDMI cable. (cable not 
provided) 

○7  RJ45 connector: Connect this device to Local Area Network (LAN) using a RJ45 cable. 
(cable not provided) 

○8  USB type B connector: Connecting this device with a PC using a USB cable. 

○9  Power connector: Connect to the AC adapter. (DC 12V, 2A) 

○10  Component video 
output connector: 

Output component video signals. 

The colors of the jacks are green, blue and red. (cable not provided) 
○11  Composite audio/video 

output connector: 
Output composite video/audio signals. 

The colors of the jacks are yellow, red and white. 
○12  Composite audio/video 

input connector: 
Input composite video/audio signals. 

The colors of the jacks are yellow, red and white. 
○13  Coaxial digital audio 

connector: 
Output S/PDIF digital audio signal. Connect this jack to an AV receiver 
with a RCA cable. (cable not provided) 
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Quick Start 
Read before use. 
1. Do not operate electronics with wet hands. 

2. Do not operate this device in a bathroom or near water. 

3. Do not bend cables in a sharp angle. 

4. Keep this device and cables out of reach of children. 

5. Keep this device and its accessories away from heat sources. 

How do I use this device? 
This device plays media contents stored in its internal HDD, in an external USB storage 

connected to it, or on a server via SAMBA Ethernet protocol. In the Home Menu, select the 

medium you want to browse and press the  ENTER button to start playback. It is also 

able to record AV signal by pressing the  REC button, or to setup a scheduled recording 

task in the Schedule of the Home Menu. 

How do I copy media files into it? 
1. Connect the AC adapter to this device. 

2. Connect this device to your computer with the USB cable. 

3. Copy files just like using a USB external HDD. You can do it with Windows Explorer or Mac 

OS Finder. (No additional software is needed!) 

4. Disconnect this device from your computer using safe remove procedure of your OS. 

How do I play media files on my TV? 
1. Connect this device to your TV with correct cables. 

2. Plug the AC adapter into the Power Connector. 

3. Press the  STANDBY button on the remote control to activate this device. 

4. Browse with the  buttons and the  ENTER button. 

What if my TV screen displays unstable image? 
Press the TV SYS button repeatedly until the image goes steady. 

What if my USB wireless dongle does not work? 
This device works with certified USB wireless dongles only. Please consult your local 

distributor to purchase a certified USB wireless dongle. Please refer to Connecting 

Wireless for more information. (page 10) 

How to configure settings? 
Press the SETUP button. 

What if I have more questions to ask? 
Please read detailed descriptions in this manual. 
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PC Connection 
OS Support 

This device supports Microsoft® Windows® Vista� / XP SP2. 

 Some USB 2.0 Host Controllers may require updated device driver files to operate 

properly. If you have problems with your USB connection, visit the Windows Update web 

site to make sure you have the latest Service Packs and device drivers installed on your 

PC before contacting technical support. 

Connecting via USB 
1. Connect the plug of AC adapter to the connector marked “DC IN”, plug the other end into 

an electric outlet. 

 Note:
 

When connecting the USB cable, be sure that the blue LED is off. 

2. Connect the USB cable to the USB type B connector. Then connect the other end to 

computer’s USB port. 

3. The computer will detect this device and you can start accessing the drive. 

 

 Note:
 

Always remove USB cable before activating this device. 

Transferring Files on a USB Connection 
Copy files into the internal HDD of this device just like using a USB external HDD. You can do 

it with Windows Explorer, Mac OS Finder, or any other applications appropriate for this job in 

your specific OS. 

 Always check that files have been copied to the device successfully. Always keep two 

copies of important files (an original and a backup). We are not liable for data loss or 

damage during file transfer or while store on the device. 

Disconnecting from USB 
In Windows: 

1. Close all programs or Explorer windows that are accessing this device. 

2. Click the Safely Remove Hardware icon ( , or ) on the System Tray and select 
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the drive letter assigned to this device. When the system message “safely removed” 

appears, unplug the USB cable from the computer. 

In Mac OS: 

1. Close all programs or Finder windows that are accessing this device. 

2. Drag the drive icon onto the Eject icon (Trash can). 

3. When the icon disappears from the Mac desktop, you can safely disconnect this device 

Installing Software 
1. Do not connect this device to computer yet. 

2. Insert the utility CD into computer’s optical drive, and then the CD Main Menu should 

automatically appear on the screen. If the Main Menu doesn’t show up, go to “My 

Computer” and browse the CD. By executing the “index.html” file, the Main Menu will 

appear. 

3. Click on “Playlist Manager”, and then follow the on screen instructions to complete 

Playlist Manager installation. 

4. Click on “Transcode Server”, and then follow the on screen instructions to complete 

Transcode Server installation. 

Installing Firmware 
1. Connect this device to computer. 

2. Insert the utility CD into computer’s optical drive, and then the CD Main Menu should 

automatically appear on the screen. If the Main Menu doesn’t show up, go to “My 

Computer” and browse the CD. By executing the “index.html” file, the Main Menu will 

appear. 

3. Click on “Install Firmware”, and then follow the on screen instructions to complete 

installation program operation. 

4. Disconnect this device from USB and then connect it to a TV.  

5. Press the  STANDBY button on the remote control to activate this device to 

complete firmware installation. It may takes 10~15 minutes for the installation to 

complete. For a firmware update operation, the blue LED may blink during the installation 

process; for a newly installed HDD, the orange LED may blink in triplet fashion. 

Using the Utility Programs 
Playlist Manager 
A playlist is a collection of media files which can be played in series. The Playlist Manager 

utility included with this device allows you to create playlists for your media files. Each playlist 

can contain only one media type (music or videos). Once you have created a playlist, you 

can play it back by selecting it and pressing the  ENTER button on remote control. A 
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total of 2,048 files can be added to a single playlist. 

 Note:
 

A playlist is an .m3u file. In addition to playlists created using the Playlist 

Manager utility, this device can use playlist files from other software players, 

such a Windows Media Play or Winamp. 

Follow the instructions below to create and manage playlists. 

1. Connect this device to your computer. 

2. To launch the utility, click Start → Playlist Manager → Playlist Manager. 

3. To create a new playlist, click the File menu and select New Playlist. The new playlist 

will appear in the lower window frame. 

4. To add files to your playlist, use the upper window to browse the media files stored on this 

device. Select the files you want to use in your playlist and press the  button. 

5. To remove files from your playlist, use the lower window to browse and select files from 

the playlist, then press the  button. 

6. To adjust the playlist sequence, select the files you want to manage and use the  or 

 button to move them a step forward or backward in the playlist. 

7. To save the playlist, click the File menu and select Save or Save as. 

 Note:
 

If a playlist does not appear on the TV when navigating this device, open it on 

your PC using the Playlist Manager and save it again. 

Transcode Server 
The Transcode Server utility included with this device allows you to play media files of 

RMVB/H.264/VC-1 codecs via network connection. A RMVB/H.264 file stored on your PC can 

be played on TV using this device. A smooth output of Transcode Server depends mainly on 

the network condition. A resolution smaller than 720x576 pixels is recommend for most 

network conditions. 

1. Connect both this device and your computer to a LAN. (page 10) 

2. Setup the Network settings of this device to obtain IP address. (page 22) 

3. To launch the utility, Click Start → Transcode Server → Transcode Server. 

4. Click the Net Share Dialog tab. 

5. Click the Add button to add a new folder to share. 

6. If you need this software to automatically launch with Windows startup, click the Setting 

tab and check the Auto Run on System Startup box. 

 Improper network or file sharing settings may cause Transcode Server service being 

unreachable. You may need to install Windows “Network Setup Wizard” on your 

computer. For more details of Windows file sharing settings, please refer to Windows 
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service manuals. 

Formatting the Internal HDD 
This device supports NTFS file system. Connect this device to a computer via USB connection 

(page 6), and then use the format utility of your OS to format the internal HDD. You may 

need to refer to the manual of your OS for detailed instruction of its format utility. 

 Formatting the drive will erase all existing data! If you have files on the drive you want to 

save, move them to another drive before reformatting. 

 Note:
 

Do not partition the internal HDD - leave it as a single large volume. Partitioning 

the internal HDD may cause this device to halt. 
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Network Connection 
Connecting Wired Ethernet 

1. Use a RJ45 Ethernet cable to connect this device to a network router, hub, or switch; or 

connect this device to the Ethernet port on a networked computer. 

2. If you have not already done so, connect this device to your TV. 

3. Connect the power supply to this device. 

4. Activate this device by pressing the  STANDBY button on the remote control. The 

orange LED on the front cover will light up during booting-up. This device will be ready to 

use when the blue LED lights up steadily. 

5. This device is automatically configured so you can browse and play back files stored on 

your network volumes. If you want to copy files from your network volumes to this device, 

you need to connect to it using a computer on the network. 

 

Connecting Wireless 
 Note:

 
This device only supports wireless dongle with Realtek RTL8187B controller. 

Please consult your local distributor or vendor website for a certified USB 

wireless dongle. 

1. Connect the wireless dongle to the USB host port on the back of this device. 

2. If you have not already done so, connect this device to your TV. 

3. Turn on your TV and change the input setting as needed to receive input from this device. 

Refer to the manual that came with the TV if you are uncertain how to do this. 

4. Connect the power supply to this device. 

5. Activate this device by pressing the  STANDBY button on the remote control. 

6. When the Home Menu displays on the TV, select Setup and press the  ENTER 

button. 

7. Select Network and press the  ENTER button. 

8. Select Wireless Setup and press the  ENTER button. 

9. Select Modify and press the  ENTER button. 
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10. This device will list available wireless networks. Select your network and press the  

ENTER button. 

 Note:
 

To enter a username and password to login to a network volume, press the 

 ENTER button on the remote control. This will bring up a virtual keyboard 

on this device TV display. Use the remote control  buttons 

and the  ENTER button to select the necessary characters. The password 

can use any combination of numbers and letters (lower case or caps). It can 

also use periods. It cannot use extended punctuation characters (such as !, @, 

#, $, %, &, etc.) 

11. Configure the settings for connection mode, wireless SSID, and wireless security. 

12. When the configuration is complete, this device will automatically connect to the 

wireless network. If it connects successfully, you will see a message indicating "Test OK 

and Show Net Info", and the Network Setup menu will display showing the IP address 

used by this device. 

13. Press the  HOME button to return to Home Menu. 

 

Connecting to this device from a Networked Computer 
 Note:

 
The network computer must be on the same subnet or network segment as this 

device. 

Manually mapping a drive letter from a Windows PC 
1. If you have not already done so, connect this device to your TV. 

2. Turn on your TV and change the input setting as needed to receive input from this device. 

Refer to the manual that came with the TV if you are uncertain how to do this. 

3. Activate this device by pressing the  STANDBY button on the remote control. 

4. When the Home Menu displays on the TV, select Setup and press the  ENTER 

button. 

5. Select Network and press the  ENTER button. The display will show the IP address 

assigned to this device on your network. 

6. Using a PC connected to the Network, right click on the Computer (Vista) or My Computer 
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(XP/2000) icon and select Map Network Drive. 

7. Select the drive letter you want to use for this device, then enter the IP address for this 

device in the field next to Folder (for example, \\192.168.1.151). 

8. You can now use My Computer or Windows Explorer to browse this device and copy files 

from your network volumes onto this device. 

Transferring Files to this device via the Network 
After mapping a drive letter to this device, you can use the standard methods for your 

operating system to create folders on the drive, then save or drag and drop files, just as you 

would to any other drive attached to your computer. By using a network connection, you can 

transfer files to and from this device while it’s connected to a TV. You can also view files 

directly from the network. 
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TV Connection 
Connecting to AV Equipments 
HDMI Connection 
The HDMI connector can output both digital audio/video signals. Many HDTV sets and digital 

AV receivers support this type of connection. (HDMI cable not provided) 

To a TV: 

 

To an AV receiver: 

 

If the HDMI cable is disconnected in playback, this device will stop playback immediately. 

 Note:
 

Some TV sets are equipped with DVI input ports, which will receive video signals 

only, but these DVI ports use HDMI connectors instead of standard DVI 

connectors. If you find no audio signal output while using HDMI connection, 

connect the Composite Audio Connection or the Coaxial Audio Connection as an 

auxiliary. 

Composite Audio/Video Connection 
The composite audio/video is compatible with most TV sets and AV amplifiers (receivers.) 

Yellow: Video signal; White: Left audio channel; Red: Right audio channel. 

 

Yellow Red

White
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Component Video Connection (Y/Pb/Pr) 
If your TV supports Component Video input (Y/Pb/Pr), you can connect it for better video 

quality. You will have to connect the audio cable for audio output. 

 Note:
 

Some TV sets are equipped with separate composite and component audio 

inputs. Be sure that you have connected the correct one. 

 

SCART Video Connection 
If your TV is equipped with SCART input, connect the Composite connectors to a SCART 

adapter to output the audio/video signal. (SCART adapter not provided) 

 

Coaxial Audio Connection 
For a high quality digital audio, you connect this connector to an AV receiver which equips a 

digital audio decoder. (RCA coaxial cable not provided) 

 

Power Connection 
Connect the DC jack of the AC adapter to the connector marked “DC IN” and plug the other 

end into an electrical outlet. 

White Green

Red Blue

Red 
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Activating for Playback 
1. Turn on your TV and AV receiver. 

2. Press the  STANDBY button on the remote control to activate this device. The 

activation takes about 5-7 seconds, and the LED will blink at the same time. 

3. After the LED stops blinking and glows steadily bright, this device is ready to use for 

playback. 

4. After playback, press the  STANDBY button again to return to Standby mode. 

 

 Note:
 

• Always remove USB cable before activating this device. 

• When using the remote control, point the remote control towards the front 

of this device. 

• When this device is off, scheduled recordings will be off. 

 When turning the HDD into Standby mode, please avoid moving it for 2-3 minutes due 

to spin down of the device. Moving the HDD while it is still spinning may damage it. We 

are not liable for any data loss or damage caused by inappropriate or careless use. 

 It is recommended to unplug the unit from the power socket completely when not in 

use. 
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Using the AV Playback Function 
When this device is connected to a TV and activated for playback, the Home Menu will 

display on the TV screen. You can also jump to the Home Menu during playback or while 

browsing other menus by pressing the  HOME button on the remote control. 

The options on the right hand side of the Home Menu allow you to select a location to 

browse for media files or select menus for configuring this device. 

To navigate the menus, use the  buttons on the remote control to move the 

highlight bar through menus, options, or files. Press the  ENTER button to open a 

folder, select an option, or play a file. Press the RETURN button to return to a previous page 

or menu. 

HDD 
Browse folders and files located on the internal HDD. 

External USB 
Browse folders and files located on an external USB device connected to the USB 2.0 host 

port on this device. 

 Note:
 

The USB device must be formatted NTFS or FAT32 to support playback on the 

TV. If the USB drive is partitioned, this device will read the first primary partition 

ONLY. 

Network 
Browse shared network volumes via SAMBA protocol when this device is connected to 

network. 

AV Input 
Switch the display to view the TV input or an AV input source connected to this device. 

Schedule 
Set up scheduled tasks to record AV input onto this device. 

 Note:
 

Set the time clock on this device before setting up a recording schedule. 

Setup 
Set up configuration options for this device. 

Browsing Media Files 
Browse media files in local storage media (Internal HDD/External USB) and in network 

storage media (Network). Playlists can only be seen in All and Music modes. 

All: All media files will be listed.  

Photo: Only photo files will be listed. Files and folders will be shown in large icons. 

Movies: Only movie files will be listed. 
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Music: Only music files will be listed. 

Press the DEL button on the remote control to delete or to rename a selected file. 

If a scheduled recording is about to start while a video file is being played, a dialogue box will 

inform you to confirm scheduled recording task. 

DVD Folder 
A DVD folder contains complete files for a DVD movie. This device can play back a movie 

from a DVD folder just like playing back a DVD disc. To create a DVD folder, connect this 

device to your computer, insert the DVD disc into the computer's optical drive, and use My 

Computer or Windows Explorer to browse the disc. Copy the entire "VIDEO_TS" folder 

from the DVD to this device. To play the DVD movie, navigate to the VIDEO_TS folder, select 

the VIDEO_TS IFO file and press the  ENTER button on the remote control. 

 Note:
 

If the DVD folder is incomplete, you can still play back the VOB files directly. 

Functions controlled by the IFO file, such as the selection of subtitles, chapters, 

and angles, will be lost 

 Some DVD discs cannot be copied because they have been protected with CSS 

protection. Always obey copyright and intellectual property rights. Do not copy DVDs 

with copyright and do not distribute them to others. 

Playing Media Files from Internal HDD/External USB 
1. Select a location to browse for the video file you want to play. Select HDD if the file is 

saved on the internal HDD or External USB if the file is located on an external USB device 

connected to this device. 

2. Browse to the folder containing the media file you want to play (use the  buttons 

on the remote control to navigate through listed folders; press the  ENTER button to 

open a folder or subfolder). 

3. Select a media file and press the  ENTER button to start playback. 

Playing Media Files from Network/Transcode Server 
You can use this device to play media files from your network on your TV. 

1. Connect this device to your TV. 

2. Connect this device to your home network. 

3. Turn on your TV and change the input setting as needed to receive input from this device. 

Refer to the manual that came with the TV if you are uncertain how to do this. 

4. Activate this device by pressing the  STANDBY button on the remote control. 

5. From the Home Menu, select Network and press the  ENTER button. 

6. The Network menu will show volumes available on your network. Use the 
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 buttons on the remote control to browse to and select media files you 

want to play. 

 Note:
 

If you need to enter a username and password to login to a network volume, 

press the  ENTER button on the remote control. This will bring up a virtual 

keyboard on the TV display. Use the remote control  buttons 

and the  ENTER button to select the necessary characters. The password 

can use any combination of numbers and letters (lower case or caps). It can 

also use periods. It cannot use extended punctuation characters (such as !, @, 

#, $, %, &, etc.) 

Viewing Recorded TV or Video 
This device saves recorded TV programs or videos in a folder named “REC”. It automatically 

names the recorded video files according to the date and time at the beginning of the 

recording. The standard filename convention uses 8-digits to identify the year, month, and 

day, followed by an underscore and 4-digits for the time on a 24-hour clock. For example, if 

you recorded a TV program that started at 7:00 p.m. on July 24, 2008, the filename for the 

recording would be 20080724_1900.mpg. This device uses MPEG-2 as the file format for 

all AV recordings. 

Use the following instructions to view an AV recording: 

1. Connect audio/video out from this device to the appropriate input connections on your TV. 

2. Turn on your TV and change the input setting as needed to receive input from this device. 

Refer to the manual that came with the TV if you are uncertain how to do this. 

3. Activate this device by pressing the  STANDBY button on the remote control. 

4. When this device Home Menu loads, select HDD and press the  ENTER button on 

the remote control. 

5. Select the REC folder and press the  ENTER button. 

6. Select the mpg file you want to view and press the  ENTER button. Use the 

filenames to identify the program by the date and time it was recorded. 

Playing Slideshow/Music Slideshow 
1. Select the image file you want to start the slideshow, then press the  ENTER button. 

This device will display all photo images in the folder consecutively with the selected 

display interval.  

2. To set the display interval for your slideshow, press the SETUP button on the remote 

control to access the Setup Menu. Select MISC → Slide Show Time, and select the 

time you want each photo to display. (page 23) 
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3. If you do not want to display the photos in slideshow mode, press the  ENTER 

button again. You can then navigate through the photos manually by pressing the 

 buttons. To return to slideshow mode, press the  ENTER button 

again. 

4. If you want to play music with your slideshow, copy the music tracks to the same folder or 

subfolder as the image files. Name the music tracks in the order you would like them to 

play, for example, track01, track02, track03, etc. 

 Note:
 

The filenames for the music tracks must list after all the image files. When 

playing the slideshow, this device will automatically start playing the first music 

track and continue to play each music track in alphanumeric order. You can use 

a maximum of 100 music files with each slideshow. 

AV Input & Schedule 
Connecting to a Video Source 
The composite audio/video AV input is compatible with most DV Cam, TV Setup Box, Home 

Video DVD and other video sources. Yellow: Video signal; White: Left audio channel; Red: 

Right audio channel. 

 

Recording TV Programs or Other Video Input 
You can record an audio/video signal from the TV or any other AV device connected to the 

composite input connectors on this device. You can start recording immediately using the 

 REC button on the remote control (one-touch recording), or you can schedule a 

recording to take place at another time. The orange LED will stay on when a recording is in 

progress. 

AV Input 
Press the  REC button on the remote control to switch to TV Input mode and start 

recording immediately. Press the  REC button repeatedly while recording to adjust 

recording time. 

If a scheduled recording is about to start while another recording is still in progress, a 

dialogue box will inform you to confirm scheduled recording task. (and hence stops the 

Yellow Red

White
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original in progress recording task.) 

Schedule 
Before setting up a scheduled recording task, it is important to setup the time clock of this 

device. (page 23) 

Start Time: Start time of the scheduled recording task. 

Length: Recording length of the task. 

Repeat: Repeat event of the scheduled task. 

Status: The status of the task 

 Note:
 

• The Status “Ready” means the scheduled task is ready. It does not imply 

the input signal is present. 

• A task must be set to start in at least 2 minutes from the current time. 

• If two tasks overlap, the later will not start recording. 

• Leave at least 1 minute between 2 adjacent tasks for the former to 

complete writing on the HDD. 

1. Select Add a new schedule and press the  ENTER button on the remote control. 

2. Use the  buttons on the remote control to set the date and time you want 

recording to start. 

3. Use the  buttons on the remote control to set the recording length in hours and 

minutes. 

4. If you want to record this program more than once, set the Repeat option you want to 

use. 

5. When you have finished setting up the record schedule, press the  ENTER button on 

the remote control and confirm the schedule. 

6. 30 sec before the start time of a scheduled recording task, a dialogue box will inform you 

to confirm the scheduled recording task. 

 Note:
 

• If the power supply is disconnected from this device or there is a complete 

power outage, it will erase the recording schedule and you will need to reset 

the recording schedule when power is restored. 

• After a new schedule is set, you can press the  STANDBY button on 

the remote control to enter standing by. The blue LED will remain on, with 2 

blinks every 5 seconds, in this Scheduled recording standing by mode. 

(page 4) 

• When this device is off, scheduled recordings will be off. 
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Setup 
Press SETUP button to enter Setup Menu. Use the  buttons to select items. Press 

the  ENTER button to enter a submenu or to confirm a selection. Press the RETURN 

button to return to previous folder. Press the  HOME button to return to Home Menu. 

Language 
Menu Language 

Select the language used to display the OSD menus and information. 

Text Encoding 
Select a language code page for additional ANSI local code subtitle support. 

 Note:
 

For DivX subtitle text files encoded in ANSI code, the Subtitle Language must be 

set to match the language of the subtitle text file. Subtitle files encoded with 

Unicode will display properly regardless of the language setting. 

Audio 
Select the language for the default audio when playing a DVD movie. 

Subtitle 
Select the language for the default subtitle when playing a DVD movie. 

Disc Language 
Select the language for DVD menus. 

Audio 
Speaker 

2 CH: Outputs stereo audio 

5.1 CH: Select for use with Dolby Digital 

Night Mode 
“Night Mode” lowers the audio output and avoids rush sound. 

OFF: Turns off night mode or the comfort option 

ON: Decreases audio output to a soft level for nighttime listening 

Comfort: Softens audio output only for sudden loud portions of an audio track 

S/PDIF 
HDMI LPCM: Use with an HDMI connection. Outputs audio signal with multi-channel 

simulation whenever possible. 

HDMI RAW: Use with an HDMI connection. Outputs digital audio without decoding. 

SPDIF LPCM: Use with a coaxial audio connection. Outputs audio signal with 

multi-channel simulation whenever possible. 

SPDIF RAW: Use with a coaxial audio connection. Outputs digital audio without 

decoding. 

Video 
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Aspect Ratio 
Pan Scan 4:3: Displays the 16:9 images in “Pan and Scan” with a 4:3 ratio TV connected. 

Letter Box 4:3: Displays the 16:9 images in “Letter Box” with a 4:3 ratio TV connected. 

16:9: Displays 16:9 images on a wide screen TV. 

Brightness 
Adjust brightness setting for video output to the TV. 

Contrast 
Adjust contrast setting for video output to the TV. 

Video Output 
Component: Outputs video signal via both composite and component connectors. 

TV System 
HDMI Auto: Outputs the optimum video quality of the TV. 

NTSC: Outputs standard NTSC video signal 

PAL: Outputs standard PAL video signal 

480P: Use the 480p output resolution with a 4:3 ratio TV in NTSC system countries. 

576P: Use the 576p output resolution with a 4:3 ratio TV in PAL system countries. 

720P 50HZ: Use the 720p output resolution with a 16:9 ratio TV in PAL system countries. 

720P 60HZ: Use the 720p output resolution with a 16:9 ratio TV in NTSC system countries. 

1080i 50HZ: Use the 1080i output resolution with a 16:9 ratio TV in PAL system countries. 

1080i 60HZ: Use the 1080i output resolution with a 16:9 ratio TV in NTSC system countries. 

REC 
Quality 

Press the  REC button repeatedly while recording to adjust recording time. 

Option Video quality (Codec: MPEG-2) Audio quality (Codec: MPEG-1 Layer2) 

HQ 8680 kbps (VBR)  
NTSC: 720 x 480 pixels, 29.97fps 
PAL: 720 x 576 pixels, 25fps 

256 kbps (CBR) 

SP 4400 kbps (VBR)  
NTSC: 720 x 480 pixels, 29.97fps 
PAL: 720 x 576 pixels, 25fps 

256 kbps (CBR) 

EP 2100 kbps (VBR)  
NTSC: 352 x 480 pixels, 29.97fps 
PAL: 352 x 576 pixels, 25fps 

256 kbps (CBR) 

Network 
When this device is connected to a network, the Network setup menu will display the IP 

address for either wired network with DHCP or wireless network. 

Wired Lan Setup 
CANCEL: Abort this operation. 

DHCP IP (AUTO): IP address for this device will be automatically assigned by the 
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Network. 

Static IP (MANUAL): Use to manually assign the IP Address, Subnet Mask, and Default 

Gateway used by this device. Use number pad on the remote control 

to enter the desired addresses. 

Wireless Setup 
Connect: After setting up the wireless access point, use this option to automatically 

connect or reconnect this device to the wireless network. 

Modify: Select to set up the wireless access point for this device. Modify will 

automatically scan for available wireless networks and allow you to set the 

login and password for the network you select. You can then configure settings 

for connection mode, wireless SSID, and wireless security. 

 Note:
 

• Please select Open System and WPA-PSK authentication when setting up 

your wireless AP. 

• Shared Key, WPA2, WPA Enterprise, and RADIUS with 802.1x 

authentication are not supported. 

System 
Time 

Set time clock used by this device. 

Use the number keys on the remote control to enter the year (4-digit format), month (1-2 

digits as needed), and day (1-2 digits). 

Enter the time in hours, minutes, and seconds on a 24 hour clock. 

Restore Default 
Set all settings to default values except the Password. 

Cancel: Abort this operation. 

OK: Restore default values. 

Update software from HDD 
By providing an update software image file, it will update software on this device. 

Cancel: Abort this operation. 

OK: Perform this update operation. 

MISC 
Slide Show Timing 

Set time to display each photo during slideshow. 

Transition Effect 
Set fade or transition options for slideshow display. 

Background Music 
This function allows you to play photo slide show and music at the same time. 

Off: Turn off this option. 
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Folder: Select playlist or folder containing music to play during slideshow. 
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Appendix 
Specifications 

STORAGE 
Storage Media 3.5” SATA HDD 
File System NTFS 

INTERFACE 
USB 2.0 USB 2.0 type A host port x 1 (300mA) 

USB 2.0 type B device port x 1 
Ethernet 10/100M RJ45 connector x 1 

Wireless Ready 
Wireless 802.11g 

(Only support certified USB wireless dongle with Realtek RTL8187B 
controller, not included) 

AUDIO/VIDEO INTERFACE 
Analog Input Composite video and stereo audio in (RCA x 3) 
Analog Output Composite video and stereo audio out (RCA x 3) 

Component video jack (Y/Pb/Pr) (RCA x 3) 
Digital Output HDMI connector x 1 

Coaxial S/PDIF output (RCA x1) 
MEDIA SUPPORT 

Audio Support MP3, AC3 (Dolby Digital Encoding), WAV, OGG, WMA 
Video Support MPEG-1, MPEG-2, MPEG-4 (AVI/ DivX 3.11, 4.x, 5.x, 6.x, HD/ Xvid/ 

MP4/ MOV) DVD Folder, DVD ISO 
Photo Support JPEG (baseline), BMP 
DVD Folder DVD Menu/Audio/Subtitle/Angle Selection 
DivX Subtitle Format IDX/SUB, SRT, SSA, SMI 
Music Slideshow Music playback during photo slideshow 

Max. Content Resolution 
Video 1920 x 1080 pixels 
JPEG 5120 x 3840 pixels (baseline) 

VIDEO OUTPUT  
TV System NTSC / PAL 
Screen Ratio 4:3 / 16:9 
Component/ HDMI NTSC(480i)/480p/PAL(576i)/576p/720p(50/60Hz)/1080i(50/60Hz) 

POWER SUPPLY 
Input AC 100-240 V, 50/60Hz 
Output DC 12V, 2A 

BATTERY OF REMOTE CONTROL  
CR2025 DC3V 

GENERAL 
Dimensions 193.8(L) x 60(W) x 130.3(H) mm 

7.63(L) x 2.36(W) x 5.13(H) inch 
Weight 427.5g / 15.08oz 
 

 Specifications are subject to change without notice. 
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 It is recommended to unplug the unit from the power socket completely when not in 

use. 

 

 Always check that files have been copied to the device successfully. Always keep two 

copies of important files (an original and a backup). We are not liable for data loss or 

damage during file transfer or while store on the device. 

 

 When turning the HDD into Standby mode, please avoid moving it for 2-3 minutes due 

to spin down of the device. Moving the HDD while it is still spinning may damage it. We 

are not liable for any data loss or damage caused by inappropriate or careless use. 

 

Error Message 
Message Solution 

Partition not Found ○1 Installing firmware on the HDD for the first time. The message will 

disappear in seconds. 

 ○2 The partition on the installed HDD has been damaged or altered by 

other software. Reinstalling the firmware again will solve this 

problem. 

 ○3 The HDD is physically damaged or not properly installed. 

Reinstalling the HDD may solve this problem; consulting your HDD 

local distributor if you find HDD physically damaged. 

 

Copyright 
Microsoft, Windows, and Windows Media Player are registered trademarks of Microsoft 

Corporation. Mac, Mac OS, and Finder are registered trademarks of Apple Inc. DivX is 

registered trademark of DivX, Inc. Manufactured under license from Dolby Laboratories. 

“Dolby” and the double-D symbol are trademarks of Dolby Laboratories. All other products 

are trademarks or registered trademarks of their respective owners and are hereby 

recognized as such. 
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